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SMARTBOARD FUNDAMENTALS

Getting Started with the SMART Board

The SMART Board is an interactive whiteboard that turns a computer and projector into a powerful tool for
teaching, collaborating, and presenting. Use the SMART Board to interact, create, focus, capture, and

simplify.
Notebook

STARTING THE SMART BOARD ;sdd

Video Player

With the SMART Board and projector connected to the computer, turn on Keyboard

Show Floating Tools

the projector and then the computer. Instant Conferendng...

The SMART Board draws power from the computer and will automatically e '

become active. The SMART Board has power when the Ready Light on the SUART settngs €
right side of the SMART Pen Tray turns a steady green.

Check for Updates and Activation
Help

SMART TooLs MENU Ext

The SMART Tools menu provides quick access to the functions that help you =~ SMARTSETTINGS

operate the SMART Board more effectively. To access SMART Tools, click

the SMART Board icon in the Windows Notification Area at the bottom right of your screen. The SMART
Tools menu will appear. On the Mac, control-click the Board Tools icon on the doc.

SMART SETTINGS (FORMERLY SMART CONTROL PANEL)

Board Tools

In the SMART Settings, you can configure a variety of hardware and software
options for the SMART interactive whiteboard. We will focus on the following:

®* Orient/Align the SMART Board MAC SMART SETTINGS
®* Pen and Button Settings including Calligraphic pen

ORIENTING THE SMART BOARD

In order to provide an accurate and appropriate response to touch, the SMART Board will need to be
orientated. This process allows the SMART Board Software to know exactly where the projected image
from the computer is located on the SMART Board surface. There are many ways to orient the board. The
easiest way is to,

. Click the question (?) key, on the SMART Board Pen Tray.
2. Click the Orient/Align button. %
3. Press your forefinger on the yellow center of each red cross in the
order specified.

Note: If the SMART Board or projector that is bumped or moved may need to be re- 2 KEY
orientated. A permanently mounted SMART board and projector require fewer

orientations.
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BASIC OPERATION

Use your finger instead of the mouse to control applications on the
SMART Board.

® Touch the screen with your finger and move it to control the

cursor on the screen

® For tasks that require double-clicking, tap the SMART Board
twice.

® Press the Right Mouse button on the Pen Tray, for tasks that
require a right-mouse click.

KEYBOARD & RIGHT CLICK

*  To write on the SMART Board, pick up one of the pens from the Pen Tray and write on the board.

* To erase any notes, put the pen down and pick up the eraser. Use it just like a traditional hand-held eraser

to erase the annotations on the SMART Board.

THE SMART BOARD PEN TRAY

Write over any computer image by picking up one of the four colored pens from the Pen Tray. To write in

a different color, place the pen back in its slot and select another.

Note: The color recognition comes from the slots in the Pen Tray rather than the

pens themselves.

PEN AND BUTTON SETTINGS

By default, the pens in the pen tray are black, red, green and blue. It is
possible to change several things about their functionality and
appearance for increased effect with certain projects or age groups.

To customize features of the pens in the Pen Tray:

1. From the Control Panel, select SMART Hardware Settings.
2. Select the pen you wish to modify.
3. Change the settings and click OK.

You can control the following features:

®  Pen Color

® Line/Eraser Thickness
* Line Start and End style
* Line Style

®  Transparency of the line

ACTIVITY 1:

Select 3 tool to mody:

roperties ?
Fill Effects
Line Style

aore.,

Thickness
sty
[—#

1. Launch SMART Notebook software.
2. Write your name using a pen from the Pen Tray or your finger.
3. Erase your name by wiping across the board with the eraser.




Note: The eraser will not work for objects created with line, ellipse or rectangle tools. These objects must be selected and

deleted.

SMART Board Tools

The SMART Notebook toolbar is divided into groups of buttons to make Notebook easier to work with.
The groups are Actions, Tools and Properties.

* Actions include common operations like page navigation, add and delete a page, and save or open a file.
However, actions also include things like inserting a table, screen capture, deleting objects, etc.. ..

* Tools are for creating shapes, drawing lines, pens for freehand writing and drawing, adding text, etc.. ..
One of the most important tools is the black Select arrow. Anytime you want to work with an object
on a page, first click the Select arrow and then select (click on) the object you want to work with.

* Properties allow you to change the look of objects that you create with the tools. Clicking a tool
automatically shows the corresponding property options for that tool. Additional property options may
be available by clicking the properties tab.

By default, the toolbar appears at the top of the Notebook page. When you are working with young
students, it may be more convenient to move the toolbar to the bottom of the page. To do this, click the
double-ended, vertical arrow on the far right of the toolbar.

Scrolling over a button on the toolbar gives a brief description of what the button does.

Actions I I Tools II Properties I
- - 3 a - s I & NI AN p E]f | g = o
& & A ; - B B A 212" A |-l Tl T :

Move toolbar top/bottom

Customize toolbar

SOME TOOLBAR BUTTONS EXPLAINED
I

* To paste an item, select the Paste “* icon.

* Undo or redo the last actions you performed, select the Undo -9 or Redo

& icons.
® Todelete an item, select it, and click the Delete X icon.

* The Screen Shade = allows gradual reveal of information to create suspense
or hide text and graphics by dragging the shade left or right, up or down.
®  There are several View Screen options that include:

O Select Full Screen option, a Full Screen toolbar will appear. To exit
the Full Screen mode, click on the Red X in the upper right corner of
the toolbar.

O Transparent Background, using Transparent Background, you can view
the desktop and windows behind the SMART Notebook window and
continue to interact with the open, transparent file. You can draw on a

u] 4

LN

BB Full Screen
[:] Transparent Background
Q Dual Page Display

50%

75%

100%

125%

150%

200%

300%

1 Entire Page

l «: Page Width ‘

VIEW SCREEN OPTIONS
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transparent page and save your notes in the file. You can also display measurement tools, take
screen captures, etc. ... If an area of the screen does not include any SMART Notebook objects,
you can interact with the desktop and applications behind the SMART Notebook window.

O Use the Dual Page Display 2 option to display two Notebook pages at a time from the
same notebook. This is a great way to compare and contrast the content on two pages.
O Entire Page: Select to show entire page in the display.
O Page Width: Select Page Width to set the page's width to the same width as the display.
Screen Capture, the Screen Capture (s tool allows you to take a snapshot of what is on the computer
screen and save it to a Notebook page. We will explore the screen capture feature later in this workshop.

8y

Use the Internet Browser button to insert a browser window on a page. Great for showing web videos.

The Document Camera requires a document camera.

Use the Select tool X to select objects for editing, moving or copying. 7

The Pen tool offers seven different pen types. Of special note are:
? Pen

74
O The Shape Recognition Pen & tool allows you to draw perfect

circles, squares, triangles as well as other shapes. Draw a shape to i 2 Crayon

understand how it works. P
#  Highlighter

O The Magic Pen rd tool is actually three tools in one. 4 Creative Pen
®  Draw a straight or curved line and the ink from the Magic Pen #, Magic Pen
will slowly disappear. All pens now offer @ shape Recognition Pen
®  Draw acircle to create a spotlight. PEN TYPES

®  Draw arectangle to create a magnifier
®  To move the spotlight or magnifier, click and drag outside of the spotlight or magnifier.
®  (lick and drag in the center of the spotlight or the magnifier window to increase its
circumference or perimeter.
O The Creative Pen has several default image stamps. You can make a custom stamp by clicking
the properties tab then choosing Line Style and selecting "Use a custom stamp image".
O Apply the fade effect to the Pen tool by clicking the pen then clicking the properties tab,
selecting Fill Effects and checking the box next to Enable ink to fade after you write it, be sure to set
the Fade time.

Use the Eraseréj tool to erase items created by the pens. Some eraser options include:
O Use the physical whiteboard eraser to erase items.
O Click the eraser tool on the toolbar. Note the size options available for the eraser.
O Draw a circle around several objects with the eraser and then tap in middle of the circle.

The Line / tool contains a variety of line options. Choose a line and then click and drag on the SMART
Board to draw it.

The Shapes @ and Regular Polygons tools contain a variety of shapes. Choose a shape and then
click and drag on the SMART Board to draw it.

The Fill e tool allows you to "fill" an outlined shape with a Solid fill, Gradient fill, Patterned
fill or Image fill. To fill an area:

a. Select the Fill tool
b. Choose the desired Fill property.




c. Click in the center of the area you wish to fill.

® Use the Text A tool to create a text box. Enter text from the
computer keyboard or click the keyboard button on the tray of the
SMART Board to load the on-screen keyboard.

Using the on-scteen Keyboard

You have the option to switch between the Classic, Number Pad,
Write, Shortcut and Simple or Simple Caps view.
® The Settings button allows you to select Sound, Number of
keys, Conversion time, Location and Keyboard
transparency.

*  Touch the desired location for your text and begin typing.
To edit text after closing the Fon# toolbar,

. Click on the Select tool.
2. Double click on the desired text. The Font toolbar will open to
allow for editing on the selected text.
3. Click anywhere outside of the textbox to close the Font toolbar.

Create and store Custom fonts by selecting the Tex# tool and then
clicking on the Properties menu. To do so,

Select the font you wish to change from the Text drop box.
Open the Properties menu.

Select the Line Style tab.

Choose the desired Color.

Select the Fill Effects tab to modify the font's Transparency.
Select the Text Style tab to modify the Font, Size and Font
Style.

7. Select the Save Tool Properties button.

AN U1 A W N =

ACTIVITY 2:

ON-SCREEN KEYBOARD BUTTON

Sound

O Click Ospeech  ®No sound

Number of keys in Classic view:
1101 9102 106

Convert viriting to text

Wait msec

Location of keys:

Kevhaard transnarency:

E‘-E‘J.’.:. £

[ Display Keyboard for system logon

oK ) [Cancel]

Add the following tools to the toolbar using the Customize the toolbar button:

* Clear Ink: Deletes any annotations from a page.
*  Clear Page: Deletes all objects from a page.
* Reset Page: Reset page to its starting point.

* Transparent Background: view the desktop and windows behind the SMART Notebook window

and continue to interact with the open, transparent file

* Internet Browser: Browse the Internet without leaving your SMART Notebook file.

Take some time to work with the tools, especially the creativity tools. Make sure to include some

formatting as well as adding additional pages to the project.

SMARTBoard Fundamentals | Copyright EduTech, 2012




Working with Objects

SELECTING OBJECTS

To select an object, click the Se/ec? X tool.

1. Tap or click on the object and a selection box with handlebars appears around
it.
2. To select multiple objects, touch the board with your finger and drag it

across the objects you want to select.
3. Select all objects by "right clicking" on the page and choosing Select All.

OBJECT'S DROPDOWN MENU

* Clone-One step copy and paste ? o
prmmmmmemm e v!
* Cut, Copy, Paste and Delete behave as they do in f~gn, j Clone Cl+D
T i Qe il Cut Ctrl+X
other applications o | oy cl+c
i 'f i Paste Ctrl+v

* Locking-Locks objects in place so they can’t be moved {

i - Delete Del
* Grouping-Merge objects to form a single object. \Yﬁ_\ﬁﬁ\

{  SetPicture Transparency...

Group and ungroup using shake gestures.

* Flip-Object s can be flipped both horizontally and Locking N
vertically Flip ,

®  Order-Allows one object to be moved behind another

* Infinite Cloner-Set Infinite Cloner and create Infinite Cloner

Link...
Sound...

dragging to another part of the page. Properties...

multiple copies of an object by clicking on an object and

* Link-Allows an object to become a link to a web page,
another page in Notebook, a file on the computer or an
attachment

® Sound-Allows sound to be added to an object
® Properties-Allows the object to be formatted
Note: some options are only usable if you have purchased the Math tools.

FORMATTING OBJECTS

Select an Object and it's Properties options appear on the toolbar. Additional options may be available by
clicking the property tab. Also, click the objects drop-down menu for editing, format and draw options.
The following are general rules and may not apply in all cases.

* Drawn Object- You can usually format outline color, line properties and transparency
* Gallery Object- You can only format outline color and transparency

® Text Object- You can usually format text color, transparency, font and style

Note: The formatting tools on the toolbar may also be used.

SMARTBoard Fundamentals | Copyright EduTech, 2012
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HANDWRITING RECOGNITION

SMART Notebook can recognize hand written text and convert it to a typewritten font.
To convert the drawn object to text:

1. Select it by dragging the Select tool across the entire handwritten text area.
2. Choose the desired Recognize option from the pull-down menu.

Recogreze "Corvert the®
Recognze “convert ths”
Recogreze ‘Convert Ths*

Recograe “convert Ths

| Recogree As »

| Cone )
V\ QY \ | Qe Cirlex

| ooy (S

Paste Chisv
Delete Ded

SAVE A NOTEBOOK

The first time you save a Notebook file you are prompted to Save As. A saved notebook file is given the
file extension .notebook. You can also open and save files by using the File menu. You can open a
previously saved Notebook file by selecting the Open File icon. There are several options for saving a
Notebook session.

Save as a Notebook File

1. Go to File on the Main Menu
2. Select either Save or Save As

Share on SMART Exchange

This option allows you to log into your SMART Exchange account and submit your notebook as a SMART
Exchange resource for others to use. The process includes filling out a form on the type of resource it is and
agreeing to the terms of the site, which include copyright compliance on the contents of your Notebook.

Save as a Gallery Item

To use your notebook page as an as a template or Gallery item,

1. Go to File on the Main Menu
2. Select Save Page as Gallery Item

SMARTBoard Fundamentals | Copyright EduTech, 2012
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EXPORT A NOTEBOOK

Export notebooks in several different file formats that include:

Export as Web Page
Use this command to generate a series of HTML files for viewing in a Web browser. A separate HTML
page is created for each page of the Notebook file.

1. Go to File on the Main Menu
2. Choose Export
3. Select Web Page

Export as Image File
Saving the Notebook file as an image will allow others to view the file content without installing Notebook

Software. There are many different formats to choose from: JPEG, PNG, GIF or BMP.

1. Go to File on the Main Menu
2. Choose Export
3. Select Image Files

Export as PDF

Use this command to generate a file that can be read using Acrobat Reader software, available free of charge
from Adobe’s Web site at www.adobe.com/products/acrobat .

1. Go to File on the Main Menu
2. Choose Export
3. Select PDF

Export as CFF
CFF (InteractiveWhiteboard Common File Format) file that can be used by other whiteboard programs.
1. Go to File on the Main Menu

2. Choose Export
3. Select CFF

Export as PowerPoint
Use this command to generate a file that can be used as a PowerPoint slideshow.
1. Go to File on the Main Menu

2. Choose Export
3. Select PowerPoint




Printing

You can also print a copy of your Notebook session.

1.
2.

Go to File on the Main Menu.
Select Print.

SCREEN CAPTURE

The Screen Capture tool allows you to "take a picture" and save it to a Notebook page. When you select

this tool, a Screen Capture toolbar appears.

Capture options

Area Full Screen Window Freehand
Capture Capture Capture Capture
ek~ Tw Ty [Twit-,

il | e -

Example: Capture an area

B Capt... [= |00
Click the Area Capture tool oy E]‘—\E]

1.

2. Then click and drag to outline the area to capture. ' ’,'LL 'l.& 'Jﬁ[_" 'J_!J

3. Switch to the SMART Board Notebook software to view and/or
edit. [[Jcapture to new page

SCREEN CAPTURE TOOLBAR
ACTIVITY 3:

1. Opena Web browser.

2. In the address bar, type: http://chiron.valdosta.edu/mawhatley/writing.htm

3. Click the link: Poor Writing Examples.

4. Pick up a pen. Make sure you have the screen capture toolbar open. Alternately, add the area
capture icon onto the floating toolbar when you customize it.

5. Click the Area button

6. Select one of the sentences in the list by clicking and dragging a box around it. Once the mouse is
released, the captured text will appear on a new Notebook page.

7. Select two more sentences by repeating steps 5 and 6.

Go back to the SMART Notebook and make the corrections to the sentences.

SMARTBoard Fundamentals | Copyright EduTech, 2012
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CUSTOMIZING THE TOOLBAR

Click Customize the toolbar or right-click on an open area of the toolbar to add new tools.

1. Drag items from the Customize Toolbar window onto the Notebook Toolbar to add them.
2. Drag items off the Notebook Toolbar to remove them.
3. Click on the Restore Defaults button to revert to the original toolbar.

Customize Toolbar 3]

x ~
‘ Actions Add or remove items by draaging them to or from the toolbar —
— éh % N . x 6b
Tools Q | J
Blank Page Clear Ink Clear Page Clone Page Delete Delete Page
o & A |
Dual/Single Page Full Screen Insert Compass Insert Geodreieck Insert Protractor Insert Ruler
Display
q —_— .
3 & => o 3
Instant Conferencing Internet Browser Measurement Tools Next Page Open Paste
© «~ il =A S &l
Pin Page Previous Page Print Properties Redo Reset Page
f | — q
Save Screen Capture Screen Shade Show All Links Show/Hide Alignment SMART Document =
Camars —
Restore Default Toolbar ] [ Restore Default Tool Properties l

CUSTOMIZE TOOLBAR WINDOW

Creating Links

Hyperlinks to Webpages, other pages in a Notebook session, documents or files are easy to create.

LINKING PAGES & FILES

. Select the text or object you wish to link.

2. Click the drop down arrow and select Link.

3. Choose cither a Web Page, Page in this File, File on this Computer. The linked file will
appear in Current Attachments.

4. Depending on which option you chose above, you will need to enter a Web address, select a
Notebook page or browse for a file on your computer.

5. Choose to Launch by clicking ecither a Corner icon or Object.

Click OK.

7. Toremove a link, follow steps 1-2 and click Remove Link.

o

b

CUSTOMIZE
TOOLBAR

LINKING FLASH & MOVIE FILES

1. Select the text or object you wish to link.




Go to Insert on the Menu.
Choose either Flash File (.swf) or Flash Video Fil (.flv).
Locate the file on your computer.

Click Open.

1B~ N

Note: You must first have the flash or movie file downloaded and available in a folder on your computer.

SHOWING LINKS

The Show All Links feature briefly highlights all objects linked to a website, file, another Notebook
page, or a sound with an animated box. To show the links in your current Notebook session,

. Click on View on the menu bar.
2. Click on Show All Links to show links at this time.
3. Click on Show All Links When Page Opens to show links each time a page opene during the

current session.

Creating and Using Tables

Create a custom table to insert data, objects, and graphics into the cells. You can apply shading to any cell
within the table, allowing for even more interactive lessons.

INSERTING A TABLE

To insert a table:

1. Click the Table “ tool. A table grid will appear.

2. Drag across the table grid to select the amount of cells desired. The table will now appear in the
center of your Notebook page.

3. To move the table to a different location, select it and click and drag on the gray square in the

upper left of the table.

ADDING IMAGES IN TABLE:

1. Select an image from the gallery.
2. Drag the image into the desired cell. (The image will automatically resize to fit the cell.)

SPLITTING CELLS:

1. Click a cell until it’s shaded.
2. Right-click on the cell again.
3. Select Split and then one of the six splitting options.

DELETING CELLS
To delete cells in your table,
1. Click and drag across the desired cell(s).

2. Once the desired area is highlighted, right-click it.
3. Select Delete Cells, or if you are deleting a column or a row select that option.
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SHADING CELLS

1. Select the desired cell(s).
2. Once the desired area is highlighted, right click it.
3. Select Add Cell Shade. (To "open" the shade, click on the cell.)

Other Notebook Features

PAGE SORTER

Page Sorter is a view option which allows you to easily see and navigate between pages contained in the
current Notebook session. Once a page has been selected, you can access a pull-down
menu to create, rename or delete pages. Within Pa ge Sorter you can organize your
content into groups.

GALLERY

The Gallery contains a variety of objects that can be used in Notebook including

some animated Flash objects. There is a search field for finding a specific gallery item
as well as tree style navigation. The gallery can be updated from Smart Tech’s
website by clicking on the update button.

ATTACHMENTS
“
This feature allows you to add and manage attachments. You can add web links, pdf
files, flash files, and all types of Microsoft office files. This allows easy access to
resources that relate to the current Notebook session. When you insert a pdf file it
creates an image of the first page of the file on your notebook.
'y

PROPERTIES

[ Auto-hide
The Properties tab shows the full range of options for a tool. To use this tab, select an  TABS
object or click on a blank area of the page, THEN click the Properties TO see
Property options for whatever you clicked.

ACTIVITY BUILDER

Create interactive lesson activities easily by using the Activity Builder. To start, click the Add-ons tab, and
then click the Activity Builder thumbnail and follow the instructions.

SMARTBoard Fundamentals | Copyright EduTech, 2012
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Floating Tools

The floating toolbar is a portable, customizable palette of tools that float over any application used S ‘
with your SMART Board. With the Floating Tools open, you have access to the same configurable 3
pens and erasers as the Pen Tray. To move the Floating Toolbar, click on the handle "dots". 32
1. By default Floating Tools appear when you open Notebook. Handle g‘
2. Select the desired tool from the palette and use it over any open application. N |~
3. Add tools to or remove tools from the current toolbar by selecting the Customize |-
Floating Tools icon. »| A4
4. To return the Floating Tools to its default state, click on the Restore Default Toolbar ./
button at the bottom. ¢
5. To customize the pen properties, choose the Properties icon on the right of selected pen. .
To hide the Floating Tools completely: S
1. Click on the SMART Board icon in the Windows Notification. On Mac, control-click the =
Board Tools icon on the doc. FLOATING
2. Select Hide Floating Tools. TOOLBAR

ACTIVITY 4:

Add the following icons to the Floating Tools palette:

*  Spotlight
®  Screen Shade

4 Magnjﬁer

®*  Pointer

Take some time to use Floating Tools over several different applications.

Presentation Tools

SPOTLIGHT

Use the Spotlight to draw attention to a particular area of the screen, just as a spotlight draws attention to
a portion of a stage. Move the spotlight to different areas of the screen.

* Tomove the Spotlight, click an area of the screen outside the spotlight and drag the spotlight.

*  Toresize the Spotlight, click and drag on the border.

* To change the transparency of the spotlight, click on the drop box and select the appropriate amount of
transparency.

* To close the Spotlight, click on the spotlight icon to turn off.
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SCREEN SHADE

The Screen Shade allows the user to cover information and reveal it slowly. To turn on the Screen Shade,
click on the Screen Shade icon. Initially, the screen covers the entire screen and includes handles on all
sides. Click on a handle and drag from the edge to reveal. To turn off the Screen Shade, click the close
button or click on the Screen Shade icon.

MAGNIFIER

Use the Magnifier to enlarge an area of the screen. Click on the Magnifier icon and two boxes appear
on the screen, a small one and a large one. Drag the smaller box over an area of the screen for that area to
appear enlarged in the larger box. To close the Magnifier, click the Close button in the upper left corner.

POINTER

The Pointer is a useful tool that displays a large arrow on the screen to help the presenter in drawing
attention to the screen. Drag the arrow at the back half to move the arrow. Drag on the arrowhead to
change the direction or rotate. To put the Pointer away, double click on the arrow.

SMART Recorder

The SMART Recorder allows you to record and play back an entire lesson. Create a video of every action
on the SMART Board with the SMART Recorder. Attach a microphone and record audio with the video.
Use SMART Video Player on the PC or QuickTime on the Mac to view the recorded movies.

1. Click on the SMART Board icon in the Windows Notification Window or on a Mac, control-click
the Board Tools icon on the doc.
2. Select Recorder to open the SMART Recorder controls. CMARTRacordar

3. Click the red Record button in the SMART Recorder toolbar to
(" Menu )| 00:00:00

record the whole screen or from the pull-down menu next to
the Record button, select Record Area.
4. To end the recording, click the Stop button. The Save As O » |l L
dialog box will appear.  ——
Select a destination to save the file in the Where drop down list.
Name the file in the Save As box.
Click Save.
Click OK.

SMART RECORDER CONTROLS

o J O\ »n

SMART Video Player

You can view movies on your SMART Board with the SMART Video Player on a PC or (use QuickTime on
a Mac). With the SMART Video Player you can write or draw over video during a presentation and capture
a single video frame into Notebook software. Use SMART Video Player to play video files located on your
computer or view content from a camera, VCR, CD-ROM or DVD. Smart Video Player is only for the PC.
Video annotation is not available on the Mac.

SMARTBoard Fundamentals | Copyright EduTech, 2012

A\




To access the SMART video player (PC only):

1. Click on the SMART Board icon in the Windows Notification Area in the lower right (near the
time).

2. Select Video Player. (A SMART Video Player window will open.)

Click on File and select Open to access a video on your computer. (You can also access video

w

footage directly from your camera by selecting Hardware.)
Browse for the desired video.

Click Open.

Click the Play button.

Lift a pen from the Pen Tray to stop the video.

N

Adjust settings as desired.

WRITING TEXT ON VIDEO OR OTHER APPLICATIONS

You can write notes on your movie using any of the pens in your floating tool bar or by simply writing on
the movie with a pen from the Pen Tray. You can right click after you have written and select Clear Ink,
or you can select Save Ink and a screen shot of your writing will appear in Notebook. You can also select
the Ink Aware Screen shot icon (2) at the top right hand corner of the page, and your notes will be saved as
a screen shot on Notebook. To close ink aware, click the red X (3).

ACTIVITY 5:

Take some time to create a movie using SMART Recorder. Save the file and play it using SMART Video
Player, Windows Media Player, and or QuickTime Player.

Controlling a PowerPoint Presentation

Control a PowerPoint presentation on the SMART Board using a three-button control bar.

Open the PowerPoint presentation and click on the Slide Show icon.

2. Move from slide to slide using the left and right arrows located in the lower left of the screen.

3. Hover the mouse in the lower left hand corner to bring up an options menu or pick up a pen from
the Pen Tray and write over top of the slide.

Note: If you return the pen to the Pen Tray without saving the note, the note will disappear the next time the screen is
touched.

SMART BOARD WRITING TIPS:

*  Write in big letters and not small ones.

*  Write in a straight line.

*  Write left to right, not vertically or right to left.

*  Constantly click the interactive screen to ensure contact points

*  Remember that the pen tray color is the line color unless customized to another color.

®  Put pen back in the tray when finished. Until put back, the computer will interpret screen touches as pen
strokes.
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APPENDIX A

Working with SMART Response

Having a SMART Response system connected to your SMART Board allows you to tally student responses,

record attendance, or post test results. Each response is recorded and then can easily be displayed on your

SMART Board along with classroom statistics to individual responses.

To include a SMART Response question set to your lesson,

1.
2.
3.

Go to Insert on the Menu.

Scroll down and select SMART Response Title Page.

Go back to Insert and select Insert SMART Response question. You will have the option of
entering Yes or No, Multiple Choice, Number, Fraction, Decimal, True or False, or Multiple
Answer questions.

Number, fraction,

Multiple choice decimal

Number,
Fraction,
Decimal

Multiple
Choice

ACTIVITY 6:
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8.
9.
10. Select the number of Points to be 5 and click Finish.

Go to Insert>SMART Response Title
Page

. . 1 Was George Washington the
Type ina Title and Type. First President of the US?

Click Add. ves
Go to Insert>SMART Response Question No
Select the Yes or No question type.

Click Next.

Type: Was George Washington the first
President of the United States?

Click Next.

Select the correct answer as Yes.

A

Note: Repeat steps 1-10 in order to practice with other Question type selections.




